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Terms of Use 
 
 
 

This manual and the software described herein are furnished under license, and are subject to a 
license agreement. The software may be used only in accordance with the terms and conditions 

of the agreement. 
 

No part of this manual may be reproduced or transmitted in any form or by any means electronic, 
mechanical, or otherwise, including photocopying and recording – without prior written 

permission of Wind Environmental Services, LLC. 
 

We have made every effort to ensure the accuracy of the material provided herein; however, the 
publishers and authors assume no responsibility whatsoever for the uses made of this material or 

for decisions based on its use. Further, we make no warranties, either expressed or implied, 
regarding the contents of this product or its fitness for any particular purpose. Neither the 

publisher nor anyone else who has been involved with the creation, production, or delivery of 
this material shall be liable for any reason. 

 
If you have any comments or suggestions concerning this manual, please forward them to Wind 
Environmental Services, LLC. Information in this manual is subject to change without notice. 
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Introduction to Wind Image™ For ArcMap® 
 
Thank you for purchasing a copy of Wind Image ™ For ArcMap® 
 
The Wind Image™ extension for ArcMap® provides a set of advanced tools that speed the 
integration of geotagged imagery within ArcGIS® by automating the conversion of raw 
geotagged images into image-aware feature classes1 that display within ArcMap®.  During the 
conversion process, Wind Image ™ automatically creates a point at the geotagged location for 
each image and associates it its image via a hyperlink, or by embedding the image directly into 
the attribute table of the feature class.  Wind Image ™ literally allows you to put your images 
less than one click away within the ArcMap® environment.  It has never been easier to map and 
visualize geotagged image location within the ArcMap® environment. 
 
Wind Image ™ also provides a number of additional functions designed to enhance your image 
collection, mapping, and sharing efforts.  For instance, with Wind Image ™ you can graphically 
edit each image in numerous ways, directly edit EXIF information, load track logs that record 
travel paths, as well as view and map images within ArcMap® once you have imported them.  
Wind Image ™ also gives you the option to auto-imprint your images with their corresponding 
coordinates, date, time, and several other useful tags.  
 
Wind Image ™ can work with all the major ArcGIS® data formats including Shapefile, Personal 
Geodatabase®, File Geodatabase®, and ArcSDE® formats.   
 
Wind Image ™ For ArcMap® truly is the best way to integrate GPS camera technology, such as 
the Ricoh 500SE ® GPS ready camera, with ESRI ArcGIS® software. 
 

Wind Image ™ Installation, Licensing and Registration 
Currently we offer Wind Image ™ with single use licensing.  This means that you must have one 
license for each machine on which you want to use it.  You must register each copy of the Wind 
Image ™ extension that you install using the instructions under the “Registering Wind Image” 
section below.  

Installing Wind Image ™ on a Windows® Machine 
 
Before you can use the Wind Image ™ extension for ArcMap®, you will need to install and 
register the software. To install the software follow these steps: 
 

1. Insert the Wind Image ™ disk media. 
2. Double click the new Wind Image ™ installation file. 
3. Follow the prompts to install. 

                                                
1 A feature class specifically designed to map the location of images within GIS, record and make accessible 
information about each image, as well as set up one or more simplified methods for accessing and working with the 
images directly from a GIS interface. 
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Registering Wind Image ™ 
Request Wind Image ™ License File 

1. Once you have installed the Wind Image ™ extension open ArcMap and click on the 
Wind Image ™ processing application “W” on the Wind Image ™ toolbar. 
(Note: If you do not see the Wind Image toolbar right click in the grey area at the top of ArcMap and right click then check the box next to Wind Image.) 

2. Click “Cancel” on the “Browse For Image folder” window. 
3. Then click “Help” and “Enter CD key”. 
4. Next Locate your CD key located inside of your CD case. 

 
Wind Image CD Key 

(Required For Registration) 
9JWT-1234-DU1A-ABCD 

See Registration guide for help located on the install CD 
 

5. Enter the CD key into the “Enter CD key” dialog box and click “OK” this will take you 
to the Wind Image ™ registration server. 

6. Your CD key will be automatically entered into the form next enter all other requested 
information and click “Next”. 
 

                                                                     
 
 

7. Verify your registration information is entered correctly and enter any comments and 
click “Place Order” to submit your license request. 
 
Saving Wind Image ™ License File From Registration Server 
 

1. To register your software click “Download ArcMap Registration File” and save the file to 
C:\Program Files\Wind Image 

2. You will need to restart ArcMap for the license to become valid. 
3. If you cannot save the license file from the server wait until you receive the license code 

email and follow the steps in the next section. 
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Entering Wind Image ™ License Code From Email 
 

1. After you receive an email with the Wind Image ™ license file continue to the next step. 
2. In the email you received with the license file select the license code, then right click and 

select copy. 
3. Open ArcMap and click on the Wind Image ™ processing application “W” on the Wind 

Image ™ toolbar. 
4. Then click “Help” and “Register”. 
5. Now right click in the Register dialog box and select paste. Your code should now be 

displayed in the “Register” window. 
6. Click “OK” to register Wind Image ™. 
7. You can now verify you have successfully registered Wind Image ™ by clicking the 

“Help” then “About” to view your registration information. 
8. Be sure to save the email with you license code in a safe place so you will have it 

in the event you need to re-install the extension at a later date. 
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Wind Image ™ Workflow Overview 

Example Workflow 
 
While each photo collection project is unique, you will find that most will follow the basic 
workflow outlined below. 
 

1. Record geotagged images with a GPS enabled camera that records coordinate 
information (and optionally attribute information) in the EXIF header of the images. 

 
2. Load images into Wind Image ™. 
 
3. Preprocess your images with the Wind Image ™ Editor to -- for instance, you can add 

redlining, adjust contrast, apply a filter, modify information stored in the EXIF header, 
and much more. (Optional) 

 
4. Generate an image-integrated feature class using the Wind Image ™ extension and the 

image locations stored in each image’s EXIF metadata. 
 
5. Import a Ricoh Tracklog with the Wind Image ™ GPS tracklog import tool. 
 
6. Dynamically view images in ArcMap® using the Wind Image ™ show photo tool. 
 
7. Map your images with the special mapping tools available in Wind Image ™ that 

streamline the incorporation of images within digital and paper mapping output. 
 

You can use the above workflow as a general guide while you work on your geophytes collection 
and mapping projects.  The following sections will explore each of these steps in further detail.  
The sections include general explanation, as well as step-by-step instructions and illustrations 
covering the seven steps outlined above.  The sections will thoroughly cover the wide array of 
functionality that comes with the Wind Image ™ extension for ArcMap®. 
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Wind Image 
Menu 

Start Wind 
Image 

Show Picture 
Thumbnail 
Tool 

Import 
Tracklog 
Command 

How to Use Wind Image ™ 

Wind Image ™ Application Components – Illustrated 
The following diagrams illustrate the various application components of the Wind Image ™ 
extension for ArcMap®.  You may find it helpful to refer back to the diagrams in this section as 
you try to understand topics and instructions discussed elsewhere in the manual. 

Wind Image Toolbar 

 

 
 
 
 
 
 
 
 
 

The Wind Image ™ Main Application Window 

 

Create GIS 
Layer From 
Images 

Browse For Image 
directory 

Rotate Selected 
Image(s) Left 
or Right 

Delete Selected 
Image(s) 

Images found in selected 
directory will automatically 
display in this window 

Main Application Menus 
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Main Application Menus 

 

Create Feature Class or ESRI® shp file from Geotagged Imagery Window 
You will use this window to generate a new feature class, or to append new image point features 
to an existing feature class.  In addition you can also generate ESRI® shp files in this window. 
You can launch it from the Wind Image ™ main application window by clicking the create 
command button, or by selecting create from the “Image(s)” menu. 
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Wind Image ™ Editor 

 
 

Editor Menus 
 

 
 
 
 
 

The selected image will appear 
in this window for editing 

Save Changes 

Undo & Redo 

Arrow Tool, Select tools, 
Pan, Magnify, and Zoom 
Tools 

Print Image 

Editor Menus 
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Wind Image ™ Editor – EXIF Data Display Panel 

 

EXIF Information Displayed 
after selecting “Show” in Exif 
Menu  

Exif Menu 
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Wind Image ™ EXIF Editor 
The EXIF editor allows you to edit the EXIF information embedded in the image file. 
 

 

Recording Geotagged Imagery – Guidance & Recommendations 
 
In order to take advantage of the useful functions in the Wind Image ™ Extension For 
ArcMap®, you must record your images with technology that can embed coordinate (and 
optionally attribute) information in each image’s EXIF header.  We recommend the Ricoh 500SE 
® GPS ready camera.  The Ricoh 500SE ® is an excellent camera that instantaneously tags 
pictures with a GPS location, Compass direction, and can also include multiple fields of attribute 
information in the image EXIF data.  However, Wind Image ™ can also work with any image as 
long as the image EXIF includes geographic location information in the proper format.              
In addition users can enter GPS information into any picture using the EXIF editor in Wind 
Image ™ (See the Wind Image ™ Editor section in this manual) 
 
There are a number of ways to tag images with geolocation information, the details of which are 
beyond the scope of this manual.  We recommend using the internet to find more detailed 
information on the subject. 
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Load Images into Wind Image ™ 

About Loading Images 
Once you have collected one or more geotagged photos in the field, you can begin using the 
Wind Image ™ extension to bring your photos into the ESRI® GIS system. 

How to Load Images into Wind Image ™ 
 

1. Start Wind Image ™ by clicking the           
button on the Wind Image ™ toolbar, 
which will start the Wind Image ™ main 
application window as shown at right. 

 
 
 
 
 
 
 
 
 
2. If a browse window does not automatically open, click the browse         button to open a 

browse window.   
3. Browse to the directory that contains the images you want to process.  

Note: This folder can be on any accessible drive connected to your computer including SD cards that are connected 
with a compatible SD card reader. 
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4. Now you will see your images in the Wind Image ™ main application window as shown 
below. 
 

 
 
At this point, you may select images to rotate, delete, browse to a new folder containing images, 
edit, create new image-integrated feature classes, etc. 

Preprocess Your Images 

About Preprocessing Your Images 
Before using Wind Image ™ to create an image-integrated feature class you may want to edit 
your images or modify EXIF information.  Wind Image ™ makes it possible for you to perform 
a host of edits that it permanently saves within each image file and EXIF header.  For instance, 
you may want to outline an important part of a photo, or manually adjust a geographic coordinate 
or attribute stored with the image.  Wind Image ™ makes it possible to make both these changes 
and more. 

Using the Wind Image ™ Editor 
The Wind Image ™ editor is the tool that allows you to edit your images directly.  It can edit 
images in three fundamental ways.  These include: 1) Adding new shapes and text directly onto 
the image, 2) Applying global commands – such as filters and effects, rotate, and flip – that 
affect the entire image, 3) Show and edit the EXIF information stored with the image.  The editor 
also has several functions that further help you explore and work with your image, such as the 
magnifier, pan, zoom, and print commands. 
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Opening the Wind Image ™ Editor 
1. To open the Wind Image ™ Image editor, simply double click on the image you want to 

edit in the Wind Image ™ main application window. (See Editor example below) 
 

 
 

Exploring the Wind Image ™ Editor 
 
Once the Image Editor opens, you will notice there are five command menus: Edit, Image, 
Draw, Commands, and Exif. There are also eleven tools displayed: save, undo, redo, arrow, 
rectangle selection, ellipse selection, pan, magnifier, zoom, zoom selection, and print. 
 

 
 
 
 
 
 

Menu Items 

The selected image will appear 
in this window for editing 

Save Changes 

Undo & Redo 

Arrow Tool, Select tools, 
Pan, Magnify, and Zoom 
Tools 

Print Image 

Editor Menus 

Commands and Tools 
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The Edit Menu 
• The Edit menu contains the following commands: 

o Undo: You may use this to undo any changes you 
make to an image prior to saving your changes. Once 
you save changes, they cannot be undone.  

o Redo: You may use this to redo the last item that you 
undid.  

o Cut: Cut and place things on the Windows clipboard.  
o Copy: Copy things onto the Windows clipboard. 
o Paste: Paste things onto the image from the Windows 

clipboard. 
o Options: Set basic program options.  For details 

about each setting simply click on the field to view a description at the bottom of 
the form. 

 

The Image Menu 
• The Image menu contains the following commands: 

o Information: Displays information about the image 
you are currently editing. 

o Change Pixel Format: Opens a window with 
several settings that allow you to adjust the pixel 
format of the image.  
§ Tip: To find out more about each setting click 

on the setting field and additional help 
information will display at the bottom of the form. 

o IPTC Data: Displays IPTC data.   
§ Note: Together, the Newspaper Association of America (NAA) and the 

International Press Telecommunications Council (IPTC) have designed a model 
to store multiple types of data (metadata) in an image.  This metadata is 
commonly known as IPTC.  Adobe Photoshop, along with many members of the 
newspaper and press industry, use IPTC to store information in images. 

o Zoom: Allows you to zoom the image to set scale ranges. 
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The Draw Menu  
The draw menu contains commands that allow you to draw shapes 
and add text directly onto the image.  This can be particularly useful 
if you want to highlight something about the image or provide 
explanatory text that will show up every time someone views your 
image.   

• The Draw menu contains the following commands: 
o Line: Draw a line. 
o Lines: Draw multiple lines at once. 
o Rectangle: Draw a rectangle. 
o Ellipse: Draw an ellipse. 
o Polygon: Draw a polygon. 
o Freehand: Draw freehand lines. 
o Text: Add text. 
o Set Text Back Color: Sets the color that will show 

up behind any text placed on the image using the add text command. 
§ Tip: By default, the text will show up in the upper left hand corner of the image.  

However, if you use the selection tools to select an area of the image prior to 
activating the text command, the text will appear within the selected area.   

o Clear Text Back Color: Clears any previously set text backing color. 
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The Commands Menu 
The Commands menu contains functions that apply a wide range of 
image modifications and manipulations.  Typically, these functions 
apply to the entire image, but you can also apply them to portions of the 
image by applying a selection to the image prior to using one of the 
commands functions.  The Commands menu functions provide you with 
a great deal of flexibility in the way you prepare your images. 
 

• The Commands menu contains the following commands: 
o Channels: Groups the following color space commands 

together: 
§ Adjust: Adjust RGB values 

• Note: RGB color space defines colors three 
individual grayscale channels: one each for 
red, green, and blue. Each of these defines the 
brightness value for their particular color for 
each pixel, and the three values combine to 
determine the actual color of each pixel.  

§ Adjust HSL: You may want to change the color of something that is 
widely dispersed throughout your image. For example, grass, leaves of 
trees or shrubs, sand etc. Since objects like grass or leaves typically 
contain a range of similar color, using the Hue/Saturation/Adjustment 
Layer is an ideal tool for selecting these objects and then applying your 
color correction. 

§ Invert: Allows you to invert one or more color channels. 
§ Shift: Allows you to shift one or more color channels  
§ Swap: This function allows you to swap color channels within the image. 

o Effects, Filters, Transforms: Three group menus that group together the 
commands depicted in the graphics below.  There are many commands to choose 
from to suit just about any image manipulation need. The best way to learn them 
is to experiment with them to see what ones will work best for purposes. 
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o Flip: This command will allow you to flip the image in any direction then create a 

mirror image of the original. 
o Rotate: This command will allow you to rotate the image. 
o Resize Canvas: This command will allow you to change the size of the image. 
o Resample: This will allow you to refresh the image. 
o Crop / Auto Crop: Using the rectangle selection or the ellipse selection this 

command will allow you to crop your images by using one of the selection tools and 
drawing a cutting fence and selecting Crop. Or, you can set it to auto crop so when 
you finish the selection area it will automatically crop the image. 

o Skew: This will allow you to skew an image offsetting the top of the image from the 
bottom of the image. 

The EXIF Menu 
The EXIF menu contains commands that you can use to view or modify the EXIF data 
embedded with the image.  This includes any special attributes stored in the EXIF, as well as the 
image’s geotagged coordinate information. 

• The EXIF menu contains the following commands: 
o Show: By selecting this command, it will display the entire 

image EXIF data for you to view. 
o Hide: This will hide the EXIF data from view giving you 

more room to view the image. 
o Edit: This will display the EXIF Editor that allows you to 

edit data fields within the EXIF header. 
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Generate Image-Integrated Feature Classes or ESRI® shp files 
Once you have loaded your images and preprocessed them 
as needed, you are ready to create a feature class or ESRI® 
shp file directly from these images.  With Wind Image ™ 
you can generate a feature class or ESRI® shp file that will 
incorporate and integrate your images into the ESRI® GIS 
system for viewing, mapping, and even analysis purposes. 

How to Generate an Image-Integrated Feature 
Class or ESRI® shp file 

1. Select the images you wish to include in the feature class 
2. Click on the Create button  
3. Browse to the location where you wish to store the new feature class and enter a name for 

the new file. 
• Note: If you choose a folder for the destination, Wind Image ™ will create a Shapefile.  If 

you choose a Geodatabase, Wind Image ™ will create a Geodatabase feature class. 
• Note: Shapefiles only allow you to link to images via a file path. Geodatabases allow you 

to embed the images inside the attribute table of the feature class (Recommended). 
 

    Save As type 
 

4. Set the output projection by clicking the browse button or leaving the default WGS 84 
Lat/Lon projection. 

5. Select the type of image integration you want, either Embedded (recommended) or 
Linked. 

• Note: Embedded is only available when creating Feature classes. 
6. If you choose to link your images, and you want Wind Image ™ to automatically rename 

them with a date and time identifier, or a custom identifier then check the corresponding 
check box. 

•  Custom – You may only check this box after clicking the “Custom Rename” 
button and assigning the custom tag you want 
Wind Image ™ to generate. (See Example right) 
                                                                              

• When using the “Custom Rename” option as 
shown in the example to the right you will enter 
the EXIF tags in the order you want the image 
renamed. 

                        (Example: %DATETIME%%RICOH1%) 
 

• Note: Doing this ensures that images copied into a 
common workspace do not overwrite each other. 
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7. If you choose to link your images, you must also select the radio button that indicates 
whether you want to copy or move the linked images. 

• By default Wind Image ™ always places the images in the directory wherein the new or 
appended feature class or shp file exists. You may select another location to store the 
images by checking the box next to “To Specified Folder”.  

8. Check the Create Border box if you want your images to have a border around them 
when displayed in your maps as a thumbnail. 

9. Set the thickness and color of the border if you decide to include them. 
10. In the Offsets box you will set the magnetic declination for your project area. The 

declination is the difference between magnetic and true north. This is important as most 
devices that give a compass direction give the direction as a magnetic measurement. And 
mapping programs use true north. To determine your declination click the calculate link. 

11. If you are using a laser device such as a LaserTechnology® TruePulse™ Laser and want 
to have the point locations set to your image target location check the “Offset based on 
Laser Device” box. 

12. Check the Imprint checkbox if you want to imprint 
information on top of the images, and then check the boxes 
that indicate the type of information you would like Wind 
Image ™ to imprint.  The options are: 

• Date and time the photo was taken  
• The image geotagged coordinates 
• Custom – You may only check this box after 

clicking the “Custom” button and assigning the 
custom tag you want Wind Image ™ to generate. 
(See Example below) 

                   
• When using the “Custom” option as shown in the example above you will first 

enter the text you wish to see imprinted followed by the operator.                  
(EXIF Tags or Ricoh Memos) 

13. Choose the type of symbology you want Wind Image ™ to assign when it loads the new 
or appended feature class as a layer in ArcMap®. 

14. Optionally, choose the field you want ArcMap® to rotate the layer symbols based on. 
15. Once you have made all of your selections, click on the create button to create or append 

to an Image Integrated feature class.  
16. Click OK if you would like to add the layer to your map.  
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How to Append to an Existing Image Integrated Feature Class 
1. To append to an existing Feature Class follow the “How to Generate an Image-

Integrated Feature Class” instructions with the following exception. 
2. After you click on the Create        button found in 

the Main Application window, browse to the feature 
class onto which you want to append new image 
records.  (See example) 

3. Click save. 
4. Configure the rest of the settings in the Create 

dialog box. 
5. Click Create to append the image feature records to 

the existing Feature Class. 
 
 
 

Import a Ricoh Tracklog 

About Importing a GPS Tracklog 
If you recorded a GPS tracklog while taking your photos, you can use Wind Image ™ to quickly 
convert the tracklog into a feature class and load it into ArcMap®.  The layer will then visually 
show you the path that you or others traveled while recording imagery in the field. 
(Note: Tracklog files from the Ricoh camera are stored on the SD card under the folder TRKLOG)    
 
Wind Image ™ creates one polyline and one point feature class for each tracklog it processes.  
By doing so, it gives you the options to view your path as a series of points, as a line, or as both. 

How to Import a GPS Tracklog 
1. Click the import tracklog button  
2. Browse to the tracklog you want to import.  
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3. Browse to the workspace where you want to save the new feature classes and give them a 
root name. 

 

 
 
4. Optionally, browse to change the output 

projection. 
5. Click Convert. 

 
 
 
Note: You cannot append to an existing feature 
class.  You must create a new one when importing a 
new GPS tracklog. 
Tip: You can use the “DtTime” (Date/Time) field 
produced inside the output feature class table with 
ArcMap® Tracking Analyst to 
animate your tracklog path. 
Requires the tracking analyst 
extension. See ArcMap® help 
system for Tracking Analyst. 
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Dynamically View Images in ArcMap® 

About Dynamically Viewing Images in ArcMap® 
A key feature offered by Wind Image ™ is an enhanced ability to dynamically view and map 
geotagged imagery.  The main way it does this is with the Show Photo tool.  The Show Photo 
tool can automatically display image thumbnails when you let your mouse pointer hover over an 
image feature point in ArcMap®.  This means that you can conveniently see the image 
associated with an image point without a single mouse click.   
 
As an added advantage, Wind Image ™ also lets you access the Wind Image ™ editor window 
so that you may continue to edit your images right from the ArcMap® map interface. 

How to Dynamically View Images in ArcMap® 
1. Click the Show Photo  button         
2. Hover your mouse cursor over an image point. 

After a short time, an image thumbnail will 
appear. 

3. Hover over another image point, and another 
thumbnail will appear 

 
Tip: You can change the size at which thumbnails display 
by the “Thumbnail Preview” settings under Wind Image 
™ settings found on the Wind Image ™ menu located on 
the Wind Image ™ toolbar. 
 

How to Open Wind Image ™ Editor from the ArcMap® Interface 
If you want to edit an image after processing, you can open the Wind Image ™ Editor window 
from a thumbnail view of an image. 

1. Click the Show Photo button         
2. Hover your mouse over an image point and wait for the thumbnail to appear. 
3. Double click the thumbnail image. 
4. The Wind Image ™ Editor window will appear with the current image loaded and ready 

for you to edit. 
1. Note: Wind Image ™ will save all edits to the linked images only; Wind Image will not 

modify the original image that existed in a different directory before processing. Images 
embedded in a feature class must be edited and saved prior to generating the feature 
class. Any edits made after processing will not be saved. 
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Map Your Images 
Wind Image ™ can automatically place the dynamic thumbnails in a layer onto the map as 
graphics.  Once placed, you can move, resize and further modify the thumbnails just like any 
other graphic in ArcMap®.  You can use the graphic thumbnails to produce hardcopy and 
dynamic maps that highlight or otherwise take advantage of your field recorded imagery. 

How to Convert Image Thumbnails to Graphics 
1. Click the Show Photo button         
2. Hover your mouse over an image point and 

wait for the thumbnail to appear. 
3. Right click on the thumbnail image 
4. Choose to Add to Layout and Wind Image 

™ will add the current thumbnail to the 
map.  

OR 
5. Choose to Add All Images to Layout and 

Wind Image ™ will add all thumbnails in 
the layer to the map. 

 
Tip: The graphic thumbnails will appear on the currently active annotation layer in ArcMap®.  Make 
sure you choose or create the annotation layer you want the thumbnails to appear on before using 
Wind Image ™ to add them to the map. 
 
Tip: Once you have add the thumbnails to the map 
as graphics, you can move, rotate, resize, and 
modify them the same way you can modify any 
graphic in ArcMap®.  The example shows a 
thumbnail graphic with a shadow effect applied in 
ArcMap®. 
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      Additional Resources 
 
 
 

For additional information on Wind Image ™ visit 
www.windenvironmental.com/windimage 

 
For additional information on ArcMap ® visit 

www.esri.com 
           or 

             support.esri.com 
 

For additional information on the Ricoh 500SE Camera visit 
www.windenvironmental.com/GPS-Camera 

 

http://www.windenvironmental.com/windimage
http://www.esri.com
http://www.windenvironmental.com/GPS-Camera
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